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Acquisition

Acquisition is the main program you need for running the MEG-recording.

Before measurement
Open: Menu -> Neuromag -> Acquisition > ! Always check for error messages in the top and check that
gantry position is automatically detected. If not, se How to restart acquisition

1. Load project
2. Load settings > If you use STI channels it is recommended that you add all STI channels, even if you

only use some of them. This is because of how the composite channels (STI101, STI102) is configured.
3. Add participant (as Patient)

Do Digitisation (save preparation)

1. Load preparation
2. Always load the settings again, after loading preparation. If the same settings are not applied on the

digitisation computer settings are unloaded.

During measurement
Use acquisition to handle the recording

1. Press GO! to start recording buffer

! Don’t forget to [[check channels|Check-channels]]

2. Check cHPI to record continuous head position
3. Check Record raw to record raw file(s)
4. Check Average to record average evoked file(s)

After measurement
1. Save data files

! If Average box was checked, the first file to save will be the average file, then the raw file

! Make sure to have a structured way of naming the files

Issues
How to restart Acquisition?
Problem: Channels are not appearing when running Acquisition. Acquisition is giving errors about “lost
connection” or “cannot connect to channels”.
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ACQUISITION

Solution: In order do the following, if your problem keeps appearing then proceed to the next step; otherwise
do not proceed:

1. Check that the correct setting is loaded (File -> Load Settings). See if the missing channels are still
missing.

2. Close and re-open Acquisition Programs (remember to save preparations if you have already begun).
3. Restart Acquisition Programs. You find this option under the Neuromag top menu, “Maintenance”.

(Menu -> Neruomag -> Maintenance -> Restart Acquisition). A terminal will pop up—type y to
confirm. The restart might take a couple of minutes. Once the restart has completed, you need to
restart Acquisition and also launch the Tuner and reload the current tunings you are using.

4. If none of the above works, you will need to do a “hard reset”. Open the text-file “hard reset” and
follow the instructions. Wait a few minutes and then restart Acquisition according to 3.
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Audio mixer

See figure below for an overview of how to control the sound mixer. The mixer should as default always be
on. If it is switched off, use the on/off switch on the backside of the mixer to switch it back on.

Figure 1: Audio mixer

A. Select input. Sound from Audiofile (3/4) and/or Stimulus Computer (5/6)

B. Select the MSR backpanal loudspeakers as output and adjust the volume.

C. Select the Control Room speakers (the small speakers next to the mixer) as output. Soundtubes always
recieve sound.

D. Talkback. Hold down either button to use the mixer to speak to the participant inside the MSR. - Left
button: speak though sound tubes. - Right button: speak though the backpanel speakers.

E. Microphone for talkback.

F. Main volume adjustment

Before measurement
1. Make sure speakers in the control room are turned on.
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AUDIO MIXER

! There are separate speakers for the stimuli audio and the talkback microphone. The left ones
are for stimuli audio and the right ones are for talkback.

2. Make sure audio mixer is on and that you have the right configuration (MSR speakers or sound tubes)

! If using the sound tubes be carful not to have too loud talkback volume

3. Check volume with participant

During measurement
Remember to press the correct talkback button when communicating the the participant (MSR speakers or
sound tubes)

After measurement
1. Turn off speakers. Do not turn off audio mixer.
2. If using sound tubes make sure to through away eartips and wipe tubes with alcohol

Issues
There is no sound to the MSR
Problem: sound from the Stimulation Computer, Audiofile, or talkback does not appear inside the MSR

Solution: Do the following

• Check that the sound on the Stimulation Computer is on and at full volume.
• Make sure that the correct input is selected (A in the figure above).
• Make sure that the correct output is selected (B or C in the figure above).
• For sound tubes: check that the sound tube amplifier is switched on. The sound tube amplifier is

located in the Stimulus Cabinet. Switch it on if it is switched off. WARNING: do not switch it on a
participant has the sound tubes in their ears.

• For backpanel speakers: check that the backpanel speaker amplifiers are switched on. The amplifiers
are located on the top shelf of the MSR Cabinet. Switch on the amplifiers (the two small boxed; they
should be blinking rapidly) and the input/output board if any are switched off.

There is no sound from the MSR/I cannot hear the participant
Problem: there is no sound from the MSR, and I cannot hear if the participant is saying anything

! Your participant should, at all times, be able to speak to you. As the first thing, after you have
positioned the participant in the scanner and left the MSR, you must test that the participant
can hear you and you can hear them.

Solution: Do the following

• Make sure that the MSR monitor (the big loudspeaker on top of the Stimulation Cabinet) is switched
on. The on/off switch is on the backside of the MSR monitor. The light in the logo on the front of the
monitor will be on when the monitor is turned on.

• Make sure that you are using the correct talkback option; i.e. using the sound tube talkback when using
the sound tubes.

• Make sure that the sound mixer is turned on. The sound also go through the video mixer; make sure
that the video mixer is also turned on. Buttons on the video mixer have a red light when they are
turned on. There is a small on/off switch on the back of the video mixer to turn it back on if it has
been turned off.
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AUDIO MIXER

Nothing is working, is there another way?
Yes, you can use the built in Triux system intercom. Do the following.

Figure 2: Intercom

! If the microphone is not plugged in find it and plug it in on the side of the MEG.

1. Dial 11 on the intercom. A two-way communication is no open.
2. Press and hold T (for a few seconds) to turn off the microphone in the control room. The MSR

microphone should still be on.
3. To temporarily open the microphone hold T and speak. Alternatively, to turn on the microphone

permanently press T briefly.
4. To close the intercom press X.
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BeyondCompare

BeyondCompare is a file-manager and ftp-client primarily used to upload your files to the Archive server.

Before measurement
No action requiered

During measurement
No action requiered

After measurement
1. To view your data path on Archive type:

your_project_name@archive.natmeg.se log in using your credentials

2. Make sure you have the local data path corresponding to the server path
3. Sync or copy files between DANA and Archive

When you have finished processing your files on DANA (eg. MaxFilter), and uploaded everything
to Archive, please delete the files from DANA in order to save space
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Check channels

After tuning and before each measurement you should check the channels.

Before measurement
1. Click GO! in the Acquisition control window
2. Browse through channels to see if everything looks alright
3. If everything looks good you are ready to start recording, if not see below

During measurement
If door is opened or between condition when recording has been stopped redo the steps above

After measurement
No action required

Issues
Fixing bad channels before recording
Problem: Jumpy or noisy channels

Solution: Use Squiddler to heat bad channels

Open: Menu -> Neuromag -> Squiddler

In Squiddler:

1. Select channel with slider
2. Open Commands, click Heat Channel. Wait until the channels settle then inspect if the channel looks

fine. Inspect if other channels have been affected by the heating.
3. Repeat 1-2 for all bad channels.
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CHECK CHANNELS

Figure 3: Squiddler
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Digitization

The digitization is the second part of the preparation. The first part is the placement of
electrodes.

Why
Head positioning should be monitored either continuously throughout the acquisition or at the start and end
of the recording. The MEG acquisition is done only with respect to the MEG device, instead of the anatomy
of the subject. Therefore, MEG devices include a subsystem to determine the position of the head with
respect to the MEG sensors. As MEG (unlike MRI) cannot directly measure the position of the head, small
coils known as Head Position Indicator coils (HPI) placed at known locations on the scalp of the subject, when
energized, will generate a magnetic field that helps us to localize the position of head in a three-dimensional
space, with respect to the MEG sensor array. If continuous head position tracking is enabled, generally small
movements are acceptable with a maximum error of 5 mm.

Information about the patient’s head position, orientation, and shape is obtained by digitizing (3D digitizer)
the standard fiducial points, HPI coils, and the required additional points creating Cartesian co-ordinates in
a 3D space. Digitization of four HPI coils, and landmarks, which include three bony fiducial points (Nasion,
left, and right pre-auricular points), and additional points, is performed.

The HPI coil positions, and hence the head position, are estimated from the coil signals. This estimation is
done several times per second, allowing the system to track also relatively fast movements. Once the head
position is estimated, the MEG signals are transformed to a reference head position. This conversion is
sequentially performed at each time point throughout the continuous (raw) data file.

Equipment
TBA

Step-by-step guide
TBA
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Electrodes (standard setup)

This is the first part of the preparation which is followed by the Digitization

The standard setup of electrodes includes: - 2 horizontal EOG - 2 vertical EOG - 2 ECG - 1 Reference - 1
Ground

Material

Figure 4: Material needed

Step-by-step guide
1. Place the participant in the wooden chair
2. Use abrasive gel to scrub where Electrodes will be placed. Usually a pie-sized portion on a cotton pad is

enough for all electrodes, and 3-5 circular wipes will do. > ! Be careful and check with the participant
so it does not hurt

3. Wipe with alcohol swaps to remove gel. Also wipe positions of the HPI coils. > ! Warn participant
that if might sting a bit

4. After letting the alcohol dry a few seconds attach the electrodes at the location indicated by the picture.
> ! You can cut away part of the electrode (not too much!) to avoid participant getting it in the eye.

Check impedance
When all electrodes are attached. Check impedance using the impedance meter.
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ELECTRODES (STANDARD SETUP)

Figure 5: Electrode placement map

1. Connect the three cables to the electrodes according to their labels.
2. Click the middle white button to turn SIGGI on and select Impedance Meter. Press white button again.
3. Read impedance for each channel, by moving the connector to the different electrodes. Impedance

levels should not be higher than 20 kΩ, but the less the better. If impedance is too high, try to
press on the electrode. If the signal is still not good, remove the electrode, clean the skin and attach a
new.

Figure 6: SIGGI impedance meter

When finished with the electrodes move on to the Digitization.
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Eye-tracker

For details on how to set-up Eye-tracker consult the User manual which is also available in the locker behind
the MSR-cabinet.

Equipment required
• The screen
• Eye-tracker

You will also need some lines of code in your Presentation scripts to initiate the eye-tracker, start calibration
procedure and start recording.

Before measurement
1. Put screen in correct position (see Screen and projector)
2. Start eye-tracker software by pressing the letter t on the keyboard, then press enter

! If you do not see a terminal on the eye-tracking PC when you turn on the screen - Check that
the screen setting of the Stimulation PC is not set in dual screen mode and that the correct input
channel is selected - Check that the eye-tracking computer is turned on. The computer is found
at the bottom of the stimulation cabinet

! To start eye-tracker in simulation mode type t -x and press enter

3. Make sure you have the right configuration for your needs and that the corneal reflection (CR) and
pupil thresholds are set.

4. Adjust eye-tracker by moving the arm or by tilting the screen a bit.
5. Make sure MISC-channels 1-6 are activated in Acquisition settings. This is where ET-data is stored.

Calibration and validation
When participant is seated in the MSR, calibrate the system then validate your calibration.

During measurement
1. Monitor eye-positions

! As participants tend to sink down a bit during recordings eye-tracking may be lost if not chair
is raised properly ! If using the table, make sure pads or participant’s hands are not blocking the
eye-tracker

2. Check calibration
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EYE-TRACKER

After measurement
1. Turn off eye-tracking software
2. Remove eye-tracker and put back in box

Eye-tracking data is saved accordingly: * MISC001 = X Left * MISC002 = Y Left * MISC003 = Pupil Left *
MISC004 = X Right * MISC005 = Y Right * MISC006 = Pupil Right

Issues
The eye-tracking program is beeping and blinking
The eye-tracker has been disconnected from the cables in the MSR. Reconnect the eye-tracker or close the
eye-tracking program.

Eyes look blurry and the pupils are not detected.
Check that the participant’s hands or paddings are not blocking the camera.
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File naming

Plan in advance how you want to name your files. You may have different conditions or times of measurement.
Plan also for how you want to name the files if you have to stop recordings.

! Acquisition does not allow special characters or spaces in the filename

Issues
Fixing wrong filenames of recordings
Problem: One or more recording is saved with a wrong filename

Solution: rename filenames (three ways)

1. Open a terminal > 1. cd to data folder (replace text with the text that applies your project): »
/neuro/data/sinhue/your_project_name/NatMEG_number/YYMMDD > 2. Rename the file: » mv
old_filename.fif new_filename.fif > 3. Press enter.

! Be aware that if a file with the new filename already exists, it will be overwritten with no option
to recover the lost data. Rename any overlapping named file first.

2. Open folder window >1. Go to /neuro/data/sinhue/your_project_name >2. Right click and rename
file

3. Open BeyondCompare >1. Open your project path >2. Right click and rename file > ! Using
BeyondCompare on DANA you can also rename files you have uploaded to Archive
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HPI

This page explain troubleshooting of HPIs during the recording, see Digitization for HPI
placement during the preparation.

Before measurement
1. Check so that the correct HPI preparation is loaded
2. Remember to check cHPI in the Acquisition window

To monitor head position, open a terminal and type:

mneHeadPos

The head position is read from the latest HPI fit. Click” Reload HPI” to update the view.

! Be aware that the head position tool does not show the actual participants head. The head
is a template head and should only be used as an approximation of the participant’s real head
position in the MEG helmet.

During measurement
1. After each time you’ve stopped a measurement you need to check the cHPI box again

You can rotate the head in the head position tool using the buttons on the GUI or by using the mouse
wheel. You can change what is displayed (helmet, transparency, HPI on/off, head point fits, etc.) by pressing
“Options. . . ”.

To view the head position from a previous file (e.g. for comparison) open a new terminal window and type:

/data/MNE/mne_visualize_hpi_file your_file_name

The your_file_name is the filename of the file you want to read including the full path

After measurement
Close head position tool

Issues
Acquisition does not ask about measuring HPI
Acquisition will automatically ask if you want to do/redo HPI fit every time you click START or RESTART.
If you pressed Skip but want to do the HPI fit anyway, you need to restart the recording.

16



HPI

Figure 7: HPI tool
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HPI

Problem: If Acquisition does not ask about measuring HPI, it might be because it has not registered the HPI
digitization. You can check if HPI is digitized in the Acquisition main window. It will either specify the time
the HPI was digitized or say “HPI: not digitized!”

Solution: load the correct preparation with the digitized HPI coil locations

! Note that every time you click start in Acquisition, it saves a new preparation, so make sure
that you note the time you saved the preparation with the digitized HPI on the digitization PC.

HPI errors

Figure 8: HPI results

Problem: Errors with HPI. It gives an error message or Suggestion is redo HPI.

Solution: 1. Make sure the correct preparation is loaded with the digitized HPI coil locations. 2. Check that
the HPI cable is connected to the panel at the side of the scanner. 3. Click “Try again” to see if the fit
has improved. 4. Make sure that all HPI coils on the participant’s head is inside the helmet. If possible,
reposition the participant, so at least three HPI coils are inside the helmet. Click “Try again” to see if the
fit has improved. If not, proceed to step six. 5. Check for loose coils that might have come off. Do not try
to re-attach them; go to step six. 6. Redo HPI/isotrak fit: Get the participant out of the scanner to the
preparation area. Then reposition/re-attach HPI coils and redo the digitization.
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Lab notebook

Figure 9: Lab notebook

The Lab notebook helps you to note important things for your project. You can add project specific details
in the Project column, subject specific details in the Subject column or measurement specific details in the
Date column. The Lab notebook is saved as json-files and txt-files in your project folder.

Before measurement
1. Start a notebook server from the desktop (if one is not already running in the Terminal)
2. Start Lab notebook from the desktop
3. Choose Project, Subjects and Date (automatically todays date)

During measurement
1. Note everything of interest for the experiment, preferably in the Date column
2. One thing to note may be subject’s sleepiness during the measurement according to the Karolinska

sleepiness scale (KSS) which should be on the desk or on the Stimulus computer’s Desktop.
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LAB NOTEBOOK

After measurement
Make sure all notes have been added and close the Lab notebook

Issues
Lab Notebook does not start
Problem: If you cannot open Lab Notebook and get and error message saying Firefox is already running.
Solution: Open a new terminal and type:

pkill -f firefox

This shuts down all Firefox processes. Then open the notebook server and the notebook from the desktop.
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Maxfilter

It is convenient to use a script to loop through your raw fif-files with MaxFilter. MaxFilter is installed on
DANA.

Before measurement
1. Copy the master /home/master/data_scripts/avg_headpos/maxfilter_avgHead.sh to your

own directory.
2. Change the settings in the headers to match your desired processing pipeline.
3. Make executable

chmod u+x <your_file_name.sh>

! To check if the file is executable type ls -l <your_file_name.sh

During measurement
No action required

After measurement
1. Run your personalized maxfilter script (cd into correct folder)

./<your_file_name.sh>

2. When analysis is done, upload to server

Maxfilter names guide
• sss: processed with Signal Space Separation.
• tsss: processed with Temporal Signal Space Separation.
• mc: applied movement correction.
• ds: data is downsampled.
• quat: quaternion; it has estimated the head movement but not done movement correction (this is

represented in quaternion format).
• avghead: TBA

Note
This pipeline is a wrapper for running Neuromag MaxFilter inside the NatMEG infrastructure at Karolinska
Insitutet, Sweden (www.natmeg.se). Neuromag MaxFilter is a commercial software licenses by Electra
Neuromag. The head position averagers are written in Python and use functions from MNE-Python
(https://martinos.org/mne/stable/index.html). The pipeline has been tested to work on DANA, but no
guarrantee is provided that it will work elsewhere!
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Monitors

Dual monitors
You can use dual monitors on the Stimulation PC if you want to run Presentation separate from the screen
shown to the participant in the MSR, for example, if you are going to show a video to the participant instead
of the Presentation screen.

1. On the Stimulation PC, right-click on the Windows desktop and select Screen Settings.
2. Change the so that the screens are extended. Confirm changes.
3. On the second screen (the one connected to the eye tracker), switch input to DVI.

Presentation will still as a default run on the first monitor. Change the monitor by changing your Presentation
project settings. Under the menu “Monitors” you change the driver from “Standard Driver” to the one with
a number.

After measurement
Remember to switch the screens back to the standard setting when you are done.
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Presentation

For an extended manual on Presentation software, see Neurobs help page, this page is only fo NatMEG
specific configurations.

Setting up the response buttons
1. Add the input ports you want to your experiment.

You need an input port which is port6 for the fORP-buttons response pads. Select the Response
Device and configure the port settings.

2. Add output ports

Here port0 is Button pad 1 and port4 is Button pad 2

3. Add response buttons

Here you need to add active buttons to the experiment, both from the Button pads and from the
keyboard, should you need it.
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PRESENTATION

Figure 10: Port settings
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PRESENTATION

Figure 11: Port input settings
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PRESENTATION

Figure 12: Port button settings
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ESEN

TAT
IO

N

Ports overview

DIGITAL
LINES

Port
num

Port
name Port function Comment Bit line 1

Bit line
2

Bit line
3

Bit line
4

Bit line
5

Bit line
6

Bit line
7

Bit line
8

PCIe-
6509

0 MEG
(1-8)

Transmit:
Event triggers
to MEG
acquisition
system

Connects to
STI101, lines 1-8
(STI001-008)

STI001 STI002 STI003 STI004 STI005 STI006 STI007 STI008

PCIe-
6509

1 AudioFile Transmit AudioFile sound
stimulator

Valve 1
ch1

Valve 1
ch2

Valve 1
ch3

Valve 1
ch4

Valve 2
ch6

Valve 2
ch7

Valve 2
ch8

Valve 2
ch9

PCIe-
6509

2 CCS trig
+ AF
trig

Transmit Triggers CCS
stimulators 1 and
2, Triggers
AudioFile

BNC 1
Aux 3

BNC 2
Aux 4

BNC 3
Line 1

PCIe-
6509

3 PAM Transmit Pneumatic valves;
PAM,
membranes,
brush robot

Valve 1
ch1

Valve 1
ch2

Valve 1
ch3

Valve 1
ch4

Valve 2
ch6

Valve 2
ch7

Valve 2
ch8

Valve 2
ch9

PCIe-
6509

4 MEG
(9-16)

Transmit:
Event triggers
to MEG
acquisition
system

Connects to
STI101, lines 9-16
(STI009-016)

STI009 STI010 STI011 STI012 STI013 STI014 STI015 STI016

PCIe-
6509

5 RealTime Receive Connected to
LPT5 for MatLab
> Presentation
interaction

Bit 1 Bit 2 Bit 3 Bit 4 Bit 5 Bit 6 Bit 7 Bit 8

PCIe-
6509

6 fORP Receive 2x4 response pads
Connects to
STI102, ch 9-16

Left
Blue

STI102
Ch 9

Left
Yellow
STI102
Ch 10

Left
Green
STI102
Ch 11

Left Red
STI102
Ch 12

Right
Blue

STI102
Ch 13

Right
Yellow
STI102
Ch 14

Right
Green
STI102
Ch 15

Right
Red

STI102
Ch 16
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DIGITAL
LINES

Port
num

Port
name Port function Comment Bit line 1

Bit line
2

Bit line
3

Bit line
4

Bit line
5

Bit line
6

Bit line
7

Bit line
8

PCIe-
6509

7 FIB
OPT

Receive Ch 1-5
Fiber-optic
gadgets Connects
to STI102, ch 1-5

STI102
Ch 1

STI102
Ch 2

STI102
Ch 3

STI102
Ch 4

STI102
Ch 5

STI102
Ch 6
(not
used)

PCIe-
6509

7 FIB
OPT

Receive Ch 7-8 CCS
stimulation,
Connects to
STI102, ch 7-8

CCS1
STI102
Ch 7

CCS2
STI102
Ch 8

LPT 1 EyeLink Transmit:
Event triggers
to EyeLink
acquisition
system

Bit 1-8 Bit 1 Bit 2 Bit 3 Bit 4 Bit 5 Bit 6 Bit 7 Bit 8

LPT 5 MatLab/
Real-
time

Transmit Connected to
PCIe-5 for
MatLab >
Presentation
interaction

Bit 1 Bit 2 Bit 3 Bit 4 Bit 5 Bit 6 Bit 7 Bit 8

AUX/
MISC

1 AUX/
MISC

Transmit/
Receive

BNC link btw
Stimulation and
MSR cabinet

Aux 3 Aux 4 Aux 5 Aux 6 Aux 7 Aux 8 Aux 9 Aux 10
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Screen and projector

Equipment required
• The screen

Before measurement
1. Drag the mirror into the right position
2. Place monitor in front of the mirror at the markings on the floor
3. Turn on projector by pressing on time at the remote control

! If participant is seated in the chair, be careful not to blind the participant with the light from
the projector

During measurement
Just remember that the participant can see what you see on the screen.

After measurement
1. Move the screen away from the chair
2. Turn off the projector by pressing twice on the remote
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Tuning

Tuning is not always needed, but recommend at least for the first measure of the day.

Before measurement
1. Open Acquisition
2. Click the menu Tools -> Tuner. The tuning tool will appear.
3. Click file -> load tuning. A message will pop up asking if you want to read the default state tuning.

Click ok.

! Optionally, you can click “measure noise” before loading the tuning and again after loading the
tuning to see the noise level. The average noise level should be around 2.5-2.7.

4. When at a satisfactory noise level, stop and save tuning (overwrite default tuning).
5. Exit the Tuner (has to be done via the File menu)

During measurement
No action required

After measurement
No action required

Issues
The average noise level is too high (> 3) after loading the default tuning
Solution: Do the following: 1. Check that there are no objects in the MSR that could be causing disturbances,
e.g. non-tested metallic stimulus equipment, left items, etc. Remove those items 2. Run new tuning: click
“measure noise” and when it has measured the noise level, click “Tune”. The tuning procedure with iterate
through tuning parameters and try to minimize the noise in the system. Each iteration takes about 20
seconds. Click “stop tuning” when the average noise level is below 2.7.

! The tuning procedure takes up to 15 min. Make sure that you have enough time to run the
tuning procedure and always check the tuning well in advance before your participant arrives.

! If sensors are missing, they are usually at a too high noise level. Ctrl-click on very noisy (or
missing) sensors and heat via the menu. If many sensors are missing you can heat all sensors (this
takes a couple of minutes). If problem remains, you might have to restart Acquisition (see this
Acquisition section) before continuing with the tuning or call for assistance.
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